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2. Introduction 
The ECPA eSubmission Viewer is a Windows application that is used to view and work with electronic 
dossiers in the formats CADDY-xml or GHSTS. Those formats are mainly used for crop protection 
submissions. 

The present document focuses on the CADDY-xml format, the description is almost equivalent for the 
GHSTS format. 

This document contains installation instructions and a quick start guide, to make you familiar with its 
basic functions. For more information about  

• the ECPA eSubmission Viewer see https://esubmission.ecpa.eu/esub-viewer  
• CADDY-xml see https://esubmission.ecpa.eu/caddy, for more information about GHSTS see 

https://esubmission.ecpa.eu/ghsts  
• eSubmission in the crop protection domain please visit the ECPA eSubmission website at 

https://esubmission.ecpa.eu/ 

3. Viewing CADDY-xml submissions 
The eSubmission Viewer can open CADDY-xml dossiers with an additional CADDY-xml viewer module 
that will be automatically installed when needed for the first time. 

https://esubmission.ecpa.eu/esub-viewer
https://esubmission.ecpa.eu/caddy
https://esubmission.ecpa.eu/ghsts
https://esubmission.ecpa.eu/
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Up to specification version 03.07.00 (released in 2014) every CADDY-xml submission contained an 
“embedded viewer” as part of its submission folder structure. The embedded viewer was launched 
by opening the file “index.html” in the default web browser of the user. This viewer is limited in 
functionality, causes issues in current web browser versions and its functionality is bound to version 
that was available at the time of the creation of the submission. 

Starting with specification version 03.08.00 (released in 2019) there is no more embedded viewer in 
the submission folder structure and the eSubmission Viewer with the CADDY-xml viewer module is 
used to display those dossiers. Both are installed once on the local PC and are then used to open all 
CADDY-xml dossiers. There is no need for an individual download / installation for every submission 
to open. 

The CADDY-xml viewer module of the eSubmission Viewer is backwards compatible and can also 
display older versions of CADDY-xml dossiers. The user can decide for those dossiers whether to use 
the embedded viewer or the viewer module. 

In case there is no installed eSubmission Viewer available, each submission with version 03.08.00 or 
later will contain a file named “caddy.html” that opens in every webbrowser and displays the content 
of the submission in a simplified static version. 

4. Download and installation instructions 
Preface 

This section describes the default installation steps on a standard Windows 10 PC for a user which 
possesses Windows access rights to download and install programs. Within companies the described 
default installation sequence is likely to vary, because 

• the company / authority distributes software only via internal software distribution 
mechanisms – this will then also affect the uninstallation procedure 

• the company / authority limits user access rights 
• the company / authority uses a proxy server with access limitations for internet access that 

prevents the eSubmission Viewer to download and install the CADDY-xml viewer module 

In those cases, you may need to consult your local IT department and deviate from the steps 
described below. The description of the possible installation scenarios is out of scope of this 
document. 

Please note that all screenshots will vary in later versions or different environments. The file name, 
versioning and date information in the screenshots are for explanation only and are not updated in 
this document for every new viewer release. 

Installation steps 

1. Open your default web browser and open the web page https://esubmission.ecpa.eu/esub-
viewer . Please read the web page for latest information that may not be part of this 
documentation. 

2. In the “Downloads” section on this page, locate the link “Download page for current 
eSubmission Viewer version” and click on it. 

3. You will see a page with a table like the following (as of September 2019 – details may 
change over time): 

https://esubmission.ecpa.eu/esub-viewer
https://esubmission.ecpa.eu/esub-viewer
http://esubmission.ecpa.eu/download/current/GHSTS/viewer
http://esubmission.ecpa.eu/download/current/GHSTS/viewer


 

ECPA eSubmission Viewer -   Guide V 1.2   - Page 4 of 15 

ECPA eSubmission Viewer Guide 

 

4. Select the line with the latest eSubmission Viewer version and click on the “Link” in the 
rightmost column “Download”. Please also look at the Release notes, if provided. 

5. Your web browser will show you a dialog like this (the details of the dialog change between 
different browsers). Please save the eSubmission Viewer setup executable file to your 
preferred download location. 

 
 

6. Save the folder to a local folder on your PC and remember the folder location. Open your 
Windows explorer and open the folder where you have just saved the setup file. DoubleClick 
on the setup file to start the installation procedure. 

7. Windows will prompt you with the following user account control mask:  

 

Please confirm the verified published “ditemis GmbH” and click “Yes” to continue. 

8. The installation wizard will start with the following screen. Please click “Next” to continue. 
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9. In the install location screen, keep the suggested destination folder and click “Next”.  

 

10. In the start menu folder dialog, keep the default suggestion and click on “Install” to start the 
installation procedure.  

 

11. During the installation you will see the progress of installation in the progress bar. The 
installation will approximately take 1-2 minutes. 
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12. After installation the completion dialog appears. It is recommended to keep the default 
setting and to click “Finish”. 

 

13. The ECPA eSubmission Viewer will be launched for the first time. Please do not yet open a 
submission right now, but test the internet connectivity first by walking through the steps in 
the next chapter. You can keep the viewer open. 
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5. Testing the internet connectivity 
In the previous chapter you have installed the eSubmission Viewer. This viewer requires so-called 
viewer modules for CADDY or GHSTS to display the submissions. The viewer modules are not part of 
the previous installation steps. eSubmission Viewer. The viewer modules are downloaded and 
updated from an eSubmission software repository hosted by ECPA on the internet when they are 
needed. A working internet connection for the eSubmission Viewer is therefore required for this 
download. 

Therefore, before describing the functionality of the eSubmission Viewer, this section describes how 
to verify whether the eSubmission Viewer has a working internet connection. 

1. Open the ECPA eSubmission Viewer and click on the Menu “Help” and then “Settings”. 

 

2. The following dialog window will appear: 

 

3. Click on the “Test connection” button at the lower end of the pane. 
When the connection test is successful you will see the following message displayed to the 
right of the button and no further action is required. 

 

In case of errors you will see a message in red like below. In this case please contact your 
local IT department for further assistance.  
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Please take a screenshot of the error message and provide it to your local IT department. 
Please refer your IT department to the chapter “IT expert information” below in this 
document. 

When you have successfully tested the internet connection for the eSubmission Viewer, you can 
close the settings dialog and proceed to the next chapter. 

6. CADDY-xml - Quick start guide 
This chapter contains a quick start guide that can be used after having installed the eSubmission 
Viewer and the internet connectivity has been successfully tested. 

• Open the eSubmission Viewer 

• Click the Menu File / Open local submission. Navigate to the folder with the desired CADDY-
xml submission to open, select the file caddy.xml and click “Open” 

 

Note 1: Dependent on your local Windows settings the file may be displayed as “caddy” only, 
with the extension “.xml” not displayed. The file type will be “XML Document” 

Note 2: From version 03.08.00 the file caddy.xml will be renamed to “main.caddy”. Please 
open this file. Alternatively, you can double-click “main.caddy” in the Windows Explorer to 
start the eSubmission Viewer automatically with this submission, as the extension “.caddy” is 
being registered as “CADDY File” with the eSubmission Viewer as default application to open 
it. As for Note 1, the file may only be listed as “main” dependent on local settings. 

 

• If this is the first time you open a CADDY-xml dossier the eSubmission Viewer will display a 
message similar to the one below. 
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Please click “Yes” to download the required viewer module. This step will only be required 
once and won’t be subsequently required for any future CADDY-xml submission of a 
specification version that can be displayed with this viewer module. It will then be 
subsequently used for all applicable CADDY-xml submissions. As in the example this is a 
dossier with version before 03.08.00 you may also use the embedded viewer, which however 
does not convey any advantages and you will be asked for every submission again. 

The progress of the viewer download and installation is displayed and the successful status 
reported as “Installation finished successfully”. Click “OK” to continue. 

 

• The CADDY-xml dossier will open in a new tab of the eSubmission Viewer. You can then start 
working as known from the embedded viewer. 
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• You can open multiple dossiers which are then displayed in different tabs. You can operate 
with the tabs in a similar manner as in any common web browser. 

Viewer manual instructions 

This manual does not contain information about the viewer-modules. 

For CADDY-xml the functionality and design of the embedded viewer has remained largely 
unchanged since 2012 and has been ported to the respective CADDY-xml viewer module. Therefore, 
the display in a tab of the eSubmission Viewer looks very similar to the previous embedded viewer 
displayed in a web browser. 

7. Shortcuts 
The eSubmission Viewer supports the following keyboard shortcuts: 

Action Shortcut 
Open submission Ctrl + N 
Close Tab Ctrl + W 
Restore last closed tab Ctrl + Shift + W 
Open Startpage Ctrl + S 
Open Help Ctrl + H 
Zoom in Ctrl + . 
Zoom out Ctrl + - 
Zoom default (100%) Ctrl + 0 

8. Functional overview 
This chapter provides an overview of the main functions of the eSubmission Viewer. 
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Menu File 

 

The menu entries in the “File” menu allow you to 
• Open a submission, accessible within the Windows Explorer from your local PC (e.g. local 

hard drive or mounted network drive) 
• Export files (currently not available for CADDY-xml submissions) 
• Export rendition (currently not available for CADDY-xml submissions) 
• See the list of “Most recently used” submissions and to select one of them to be opened in 

the eSubmission Viewer 
• Exit the eSubmission Viewer 

Menu View 

The menu entries in the “View” menu allow you to zoom in / zoom out to change the display size 
within the content area. 

  

A similar functionality is available from the breadcrumb menu in the upper right corner: 

 

Menu Tabs 

The eSubmission Viewer supports the parallel loading and display of multiple submissions in different 
tabs. This menu allows you to close the current tab (also possible by clicking the  icon at the right 
side of the tab) and to restore the last closed tab. 

 

Menu Help 

The menu entries in the “File” menu allow you to 
• Open a sample help file. Your company / authority may decide to provide a custom help file 

by updating the file “help\help.html” in the installation folder. 
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• Open the default start page of the eSubmission Viewer. Your company / authority may 
decide to provide a custom start page by updating the file “startpage\startpage.html” in the 
installation folder. 

• Open the Settings pane of the eSubmission Viewer (see separate chapter) 
• Open the About dialog to see the current version, credits and further information. 

 

9. Viewer settings 
The viewer settings allow to further customize the eSubmission Viewer for the needs of a company / 
authority or the individual user. 

Application Settings 
• You can change the startup behaviour. It is recommended to keep the default settings. You 

will then be automatically informed about updates of the viewer itself or any viewer module. 
• Do not apply changes to the Repository settings. Changes may occur only, if a company / 

authority decides to host their own eSubmission Viewer repository. 
• The lower part allows to test the connection to the software repository and to change proxy 

configuration is required (see chapter above). 

 

Here is an example for the information of a new viewer version, when “Automatically check for 
updates” is selected: 
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Viewer versions 

This pane displays available viewer versions. You can manually download the setup file for the viewer 
version from this pane. If you download and install yourself, please make sure that you properly 
uninstall the currently installed version. Only one viewer version can be installed at a time. 

Please note that this functionality should not be used, if you company / authority is provisioning the 
eSubmission Viewer software differently. In this case you may want to inform your local IT to add the 
new version to the internal software distribution. 

 

Viewer module versions 

This pane shows available viewer modules for all versions and their installation status. If they are not 
yet installed, you can install them manually from here. This is usually not required, as the 
eSubmission Viewer will download and install the required viewer module automatically when the 
first dossier of a format is opened. 
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Help 

This pane displays the same information as via the Menu “Help / Viewer Help” 

Change of defaults in customized installations 

The locally configurable settings are stored in the file “eSubmissionViewer\config\app.data” in JSON 
format below the installation directory. If a company / authority wants to change the default settings 
as part of a customized installation, the respective values can be changed in this file with care. 
Thorough testing of this modification is required. 

 

10. IT expert information 
The following information is intended for IT specialists and can be skipped by end users. 

Advanced internet access configuration 

Connection errors are most likely due to specific proxy settings or proxy authentication issues. The 
eSubmission Viewer supports an advanced proxy configuration. To activate those configuration 
options, open the viewer settings via Help / Settings and deselect the checkbox “Automatic proxy 
configuration”. A field to enter the URL for a Proxy PAC script is available.  

If a PAC script is not available, please click on the dropdown arrow next to “advanced proxy 
configuration” to display further options for expert configuration. 

 

Please see the chapter below for a backup option of a manual download of a viewer module. 

Manual download of a viewer module 

If for some reason the internet connectivity of the eSubmission Viewer cannot be established, the 
required viewer-modules may also be downloaded separately using the default web browser 

The information in XML form about the eSubmission Viewer versions and the viewer modules are 
located in the file 
http://esubmission.ecpa.eu/download/eViewer/esubmission_software_configuration.xml  

To install the lastest CADDY-xml viewer modules please locate the appropriate section in the XML file 
(latest version with submission_format=”CADDY”): 

http://esubmission.ecpa.eu/download/eViewer/esubmission_software_configuration.xml
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Append the value of the element Download to the root URL 
http://esubmission.ecpa.eu/download/eViewer/ (e.g. in the above example 
http://esubmission.ecpa.eu/download/eViewer/viewer-
module/caddy/caddy_viewer_module_00.09.00.zip.bin ) to download the viewer module separately. 

The file can then be copied into the following local folder of the user 
“%appdata%\ECPA\eSubmissionViewer\repo\viewer-module”. The viewer module will be unpacked 
and installed automatically the next time, the eSubmission Viewer starts. 

Commandline to open a submission 

The eSubmissionViewer can be called from the Windows commandline and is able to load 
submissions with the comman line argument "--submission". 

Here is an example for a command line execution: 

eSubmissionViewer.exe --submission="C:\ghsts\dossier\01\main.caddy" 

11. Contact information 
For further technical information about the eSubmission Viewer please contact the helpdesk via the 
CADDY technical support contact (see details on http://esubmission.ecpa.eu/contact ). Individual 
technical customizations and enhancements (e.g. dossier annotations, connectivity to document 
management systems) can be discussed, if financed by the requesting party. 

Please note that this contact can only assist with general information about the ECPA eSubmission 
Viewer and cannot help with issues due to local characteristics of the IT environment. 

--- end of document --- 

http://esubmission.ecpa.eu/download/eViewer/
http://esubmission.ecpa.eu/download/eViewer/viewer-module/caddy/caddy_viewer_module_00.09.00.zip.bin
http://esubmission.ecpa.eu/download/eViewer/viewer-module/caddy/caddy_viewer_module_00.09.00.zip.bin
http://esubmission.ecpa.eu/contact
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